You can read the recommendations in the user guide, the technical guide or the installation guide for NEC MH110. You'll find the
answers to all your questions on the NEC MH110 in the user manual (information, specifications, safety advice, size, accessories,
etc.). Detailed instructions for use are in the User's Guide.
User manual NEC MH110
User guide NEC MH110
Operating instructions NEC MH110
Instructions for use NEC MH110
Instruction manual NEC MH110
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Manual abstract:
@@It is recommended that a hearing aid compatible headset be used by hearing aid users. Changes or modifications to this equipment not approved by NEC
Business Solutions Ltd. may cause this equipment to not comply with part 15 of the FCC rules and void the user's authority to operate this equipment.
WARNING NEC Business Solutions Ltd. products contain no user-serviceable parts inside. Refer servicing to qualified service personnel. WARNING NOTE
CONCERNING THE WIRELESS TELEPHONES: This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired
operation. RADIO FREQUENCY (RF) INFORMATION: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures: · Reorient or relocate the receiving antenna. · Increase the separation between the
equipment and receiver. · Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
· Consult the dealer or an experienced radio/TV technician for help. OPERATIONAL WARNINGS: For Vehicles Equipped with an Air Bag: Do not place a
portable radio product in the area over the air bag or in the air bag deployment area. An air bag inflates with great force. If a portable radio is placed in the
air bag deployment area and the air bag inflates, the radio product may be propelled with great force and cause serious injury to occupants of the vehicle.
Potentially Explosive Atmospheres: Turn off your radio product, prior to entering any area with a potentially explosive atmosphere, unless it is a radio
product type especially qualified for use in such areas (for example, Factory Mutual Approved).
Do not remove, install, or charge batteries in such areas. Sparks in a potentially explosive atmosphere can cause an explosion or fire resulting in bodily
injury or even death. The areas with potentially explosive atmospheres referred to above include fueling areas such as below decks on boats, fuel or chemical
transfer or storage facilities, areas where the air contains chemicals or particles, such as grain, dust or metal powders, and any other area where you would
normally be advised to turn off your vehicle engine. Areas with potentially explosive atmospheres are often but not always posted. CAUTION Batteries: All
batteries can cause property damage and/or bodily injury, such as burns if a conductive material such as jewelry, keys, or beaded chains touches exposed
terminals. The conductive material may complete an electrical circuit (short circuit) and become quite hot. Exercise care in handling any charged battery,
particularly when placing it inside a pocket, purse, or other container with metal objects. Cleaning and Drying Considerations: Using a leather carry case
may help protect the surfaces and help prevent liquids (e.g., rain) from entering into the interior of the radio product.
This product is not waterproof, and exposing the unit to liquids may result in permanent damage to the unit. If your Wireless Telephone interior gets wet, then
do not try to accelerate drying with the use of an oven or a dryer as this will damage the Wireless Telephone and void the warranty. Instead, do the following:
1. Immediately power off the Wireless Telephone. 2. Remove Battery Pack from Wireless Telephone. 3. Shake excess liquid from Wireless Telephone. 4. Place
the Wireless Telephone and Battery Pack in an area that is at room temperature and has good airflow.
5. Let the Wireless Telephone and Battery Pack dry for 72 hours before reconnecting the Battery Pack and/or powering on the Wireless Telephone. If the
Wireless Telephone does not work after following the steps listed above, contact your dealer for servicing information. Electro Magnetic
Interference/Compatibility: Nearly every electronic device is susceptible to electromagnetic interference (EMI) if inadequately shielded, designed or
otherwise configured for electromagnetic compatibility. NOTE Facilities To avoid electromagnetic interference and/or compatibility conflicts, turn off your
radio product in any facility where posted notices instruct you to do so.
Hospitals or health care facilities may be using equipment that is sensitive to external RF energy. Medical Devices Pacemakers: The Health Industry
Manufacturers Association recommends that a minimum separation of 6 inches (15 cm) be maintained between a handheld wireless radio product and a
pacemaker. These recommendations are consistent with the independent research by, and recommendations of, Wireless Technology Research. Persons with
pacemakers should: · ALWAYS keep the radio product more than 6 inches (15 cm) from their pacemaker when the radio product is turned ON. · Not carry the
radio product in a breast pocket.
· Use the ear opposite the pacemaker to minimize the potential for interference. · Turn the radio product OFF immediately if you have any reason to suspect
that interference is taking place. Hearing Aids: Some digital wireless radio products may interfere with some hearing aids. In the event of such interference,
you may want to consult your hearing aid manufacturer to discuss alternatives. Other Medical Devices: If you use any other personal medical device, consult
the manufacturer of your device to determine if it is adequately shielded from external RF energy. Your physician may be able to assist you in obtaining this
information. Use While Driving Check the laws and regulations on the use of radio products in the area where you drive. Always obey them. When using the
radio product while driving, please: · Give full attention to driving and to the road. · Use hands-free operation, if available.
· Pull off the road and park before making or answering a call if driving conditions so require. INTERNATIONAL CERTIFICATIONS: Australia Brazil NEED
NEC BARCODE Canada 2128-K1374 European Union Switzerland Switzerland Japan Mexico New Zealand Singapore Z233 IDA United States IEC 60950
Part 15, part 68 United States MH110 Wireless Telephones SPECIFIC ABSORPTION RATE (SAR) INFORMATION: Your wireless handheld portable
telephone is a low power radio transmitter and receiver.
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When it is ON, it receives and also sends out radio frequency (RF) signals. In August 1996, the Federal Communications Commissions (FCC) adopted RF
exposure guidelines with safety levels for hand-held wireless phones. Those guidelines are consistent with the safety standards previously set by both U.S. and
international standards bodies: · ANSI C95.1 (1992) American National Standards Institute · NCRP - Report 86 (1986) National Council on Radiation
Protection and Measurements · ICNIRP (1996) International Commission on Non-Ionizing Radiation Protection; · DHWC - Safety Code 6 Department of
Health and Welfare Canada Those standards were developed by independent scientific organizations through periodic and thorough evaluation of scientific
studies. The standards include a substantial safety margin designed to assure the safety of all persons, regardless of age and health. The exposure standard
for wireless mobile phones employs a unit of measurement known as the Specific Absorption Rate, or SAR.
The SAR limit set by the FCC is 1.6W/kg. In the United States and Canada, the SAR limit for mobile phones used by the public is 1.6 watts/kg (W/kg) averaged
over one gram of tissue. The standard incorporates a substantial margin of safety to give additional protection for the public and to account for any variations
in measurements.
NOTE Tests for SAR are conducted using standard operating positions specified by the FCC with the phone transmitting at its highest certified power level in
all tested frequency bands. Although the SAR is determined at the highest certified power level, the actual SAR level of the phone while operating can be well
below the maximum value. This is because the phone is designed to operate at multiple power levels so as to use only the power required to reach the network.
In general, the closer you are to a wireless base station antenna, the lower the power output. Before a phone model is available for sale to the public, it must
be tested and certified to the FCC that it does not exceed the limit established by the government-adopted requirement for safe exposure.
The tests are performed in positions and locations (e.g., at the ear and worn on the body) as required by the FCC for each model. While there may be
differences between the SAR levels of various phones and at various positions, they all meet the government requirement for safe exposure. The FCC has
granted an Equipment Authorization for this model phone with all reported SAR levels evaluated as in compliance with the FCC RF emission guidelines. SAR
information on this model phone is on file with the FCC and can be found under the Display Grant section of http://www.fcc.gov/oet/ fccid after searching on
FCC ID IYGRNP2400. Additional information on Specific Absorption Rates (SAR) can be found on the Cellular Telecommunications Industry Association
(CTIA) web-site at http:// www.wow-com.
com. The only authorized headsets that may be utilized with the SNP2400 are those obtainable from SpectraLink or it's reseller partners. The measured SAR
of the SNP2400 Wireless Telephone is 0.61W/kG @ 2462 MHz (head) 0.0379W/kG @ 2412 MHz (body). Phone Operation Normal Position: Hold the phone
as you would any other telephone, with the earpiece to your ear and speak into the microphone. The internal antenna is then positioned properly. CAUTION
MH120 SPECIFIC ABSORPTION RATE (SAR) INFORMATION: Your wireless handheld portable telephone is a low power radio transmitter and receiver.
When it is ON, it receives and also sends out radio frequency (RF) signals. In August 1996, the Federal Communications Commissions (FCC) adopted RF
exposure guidelines with safety levels for hand-held wireless phones.
Those guidelines are consistent with the safety standards previously set by both U.S. and international standards bodies: · ANSI C95.1 (1992) American
National Standards Institute · NCRP - Report 86 (1986) National Council on Radiation Protection and Measurements · ICNIRP (1996) International
Commission on Non-Ionizing Radiation Protection; · DHWC - Safety Code 6 Department of Health and Welfare Canada Those standards were developed by
independent scientific organizations through periodic and thorough evaluation of scientific studies. The standards include a substantial safety margin
designed to assure the safety of all persons, regardless of age and health.
The exposure standard for wireless mobile phones employs a unit of measurement known as the Specific Absorption Rate, or SAR. The SAR limit set by the
FCC is 1.6W/kg. T In the United States and Canada, the SAR limit for mobile phones used by the public is 1.6 watts/kg (W/kg) averaged over one gram of
tissue.
The standard incorporates a substantial margin of safety to give additional protection for the public and to account for any variations in measurements.
NOTE Tests for SAR are conducted using standard operating positions specified by the FCC with the phone transmitting at its highest certified power level in
all tested frequency bands. Although the SAR is determined at the highest certified power level, the actual SAR level of the phone while operating can be well
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There are step-by-step instructions for the procedures you need to perform. How this Guide is Organized Chapter 1 Introduction Chapter 2 Using the MH
110 Wireless Telephone Chapter 3 Using the MH110 Desktop Charger Chapter 4 Care of the Wireless Telephone and Chargers This chapter outlines how to
use the manual, including the organization, chapter layout, and conventions used in the Mobile Handset 110 Wireless Telephone and Desktop Charger User
Guide. This chapter introduces you to the MH110 Wireless Telephone and describes steps for making, answering, and managing your calls. This chapter
describes how to use and clean the MH110 Desktop Charger. This chapter discusses the care of the MH110 Wireless Telephone and the MH110 Desktop
Charger. Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 1-2 Introduction Document Conventions This guide uses the
conventions listed in Table 1-1. Table 1-1 Document Conventions When you see: It means: Field names Button names Click Save.
Example Enter the ID in the Name field. Select the names from the Employees drop-down list. Boldfaced Drop-down list names Enter login admin at the
command Commands, keywords, or other prompt. user input Menu names Capitalized Window names Dialog box names Menu > Submenu (boldfaced font)
CTRL+S CTRL+Shift+S (boldfaced font) F1 Click Right-click Shortcut keys Function keys Click the left mouse button Click the right mouse button Press
CTRL+S to save your changes. Press F1 to access the online help. Click OK to save your changes. Right-click and select Delete from the shortcut menu. Used
to warn against possible human injury or risk of death from an action or event. Menu paths From the File menu, choose Save. From the Directory window,
select Edit > Modify.
Click OK to save and close the Account Properties dialog box. Select Edit > Modify. Warning Caution Used when equipment or data could be damaged by an
action or event. Important Emphasizes a MUST read statement. Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1
Introduction 1-3 When you see: Note It means: Example Used to point out special details that you must know or actions that you must take relevant to your
current actions.
Describes time-saving ideas and other useful information for completing procedures. Tip Reference Indicates a reference to another related document. Stepby-step instructions are numbered. If more than one option is available to complete a task in a procedure, the options may appear as follows: Step 1 Do one
of the following to add a field to the Employee directory. --Select the desired field from the Employee field and click Add.
--Double-click the desired field from the Employee field. Step 2 To select all of the available fields, click Add all. Mobile Handset 110 Wireless Telephone and
Desktop Charger User Guide - Revision 1 1-4 Introduction Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 Using the
MH 110 Wireless Telephone 2-1 Using the MH 110 Wireless Telephone This chapter introduces you to the MH110 Wireless Telephone and describes steps for
making, answering, and managing your Wireless Telephone. Figure 2-1 shows the main elements of the MH110. Figure 2-1 Mobile Handset 110 Wireless
Telephone Line Indicators Left arrow Low battery icon Up Select Down Softkey A Softkey B Power On/Start Call Earpiece Right arrow Voicemail icon Start
Menu & Main display area Softkey Function display area Softkey D Softkey C Power Off/End Call Menu Function Charging contacts Line Microphone
Headset jack (not to scale) Chapter Topics · · · · · · · · · · · Turning the Wireless Telephone On or Off Making a Call Answering A Call Activating System
Features Using the Softkeys Status Indicators The Wireless Telephone Headset Setting User Preferences User Option Menu Battery Packs Removing and
Replacing the Battery Packs Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 2-2 Using the MH 110 Wireless
Telephone Turning the Wireless Telephone On or Off Use the following steps to turn on your MH 110 Wireless Telephone. Step 1 Step 2 Press and hold the
Power On/Start Call key for about one second. Two chirps will sound. Release the Power On/Start Call key and the in-service tone sounds as the extension
number displays. The Wireless Telephone is now in standby mode and ready to make and receive calls. Use the following step to turn off your MH 110
Wireless Telephone.
Step While in standby mode, press and hold the Power Off/End Call key. One chirp sounds and the Wireless Telephone turns off. The Wireless Telephone
cannot be turned off during a call. End the call first and then turn the Wireless Telephone off. NOTE Making a Call Use the following steps to make calls. Step
1 Step 2 Go Off Hook by pressing the Power On/Start Call key. Press the LINE key to select a line and the number key of the line you wish to use. You may
hear a dial tone. Your telephone system may require you to select a line before dialing a number. NOTE Step 3 Dial the number.
NOTE Dial calls with the Wireless Telephone exactly as with your desk phone. You may dial extension numbers, internal numbers, or make external calls,
depending on the setup of your PBX. If you hear a dial tone, just press the number keys to dial the number. Mobile Handset 110 Wireless Telephone and
Desktop Charger User Guide - Revision 1 Using the MH 110 Wireless Telephone 2-3 Answering A Call When an incoming call is received the Wireless
Telephone rings or vibrates to alert you of an incoming call. Additionally, a line number on the display may flash, and the display may show information
about the call, such as caller's name and extension.
@@The line number on the display may be flashing. @@@@At the end of each call, press the Power Off/End Call key. Be sure to do this at the end of each
call. @@@@@@@@A feature menu displays in the main display area. This is the shortcut menu.
@@@@@@@@This is the shortcut key that activates that feature. @@@@@@@@@@@@@@@@The softkeys are referred to from left to right as
A,B,C,D. @@@@@@Use the following steps to view all of the features that can be activated through the softkeys. Step 1 Briefly press the Power On/Start
Call key to go off hook. Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 2-6 Using the MH 110 Wireless Telephone
Step 2 Press the FCN key. The second set of feature abbreviations displays in the softkey display area (Figure 2-2). --Each time the FCN key is pressed, a
different set of features displays until all 16 possible features have been displayed. --The softkey features display in the same sequence as they appear on the
shortcut menu. Step 3 Press the corresponding softkey to activate any feature while its abbreviation is displayed.
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Activating Features With The Shortcut keys While scrolling through the softkey functions, a shortcut key may be pressed to activate its corresponding
feature, whether or not that feature is currently displayed in the softkey function display area.
Because system features vary, your system administrator will explain them in reference to your telephone system. Example: Using the previous example for
the Transfer function described on page 2-4: If the Transfer function is assigned to softkey A in the second level row, then Xfr displays in the Aaaa softkey
display area when the FCN key is pressed. If a call is in progress, do one of the following to activate the Transfer feature: · Press FCN + (softkey A) to
transfer the call. · Press FCN + 2 to use the shortcut key. · Press MENU + 2. Refer to the example of using the shortcut keys on page 2-4 for more information
about using MENU + 2. REFERENCE Status Indicators Table 2-3 describes the status indicators in the MH 110 Wireless Telephone. Mobile Handset 110
Wireless Telephone and Desktop Charger User Guide - Revision 1 Using the MH 110 Wireless Telephone 2-7 Table 2-3 MH 110 Status Indicators Status
Indicators No Service Message Descriptions An alarm sounds and a descriptive message displays when the Wireless Telephone cannot receive or place calls.
You may be outside of the covered area. Walk back into the coverage area.
The in-service tone indicates service is re-established. If functionality does not return, note the error message and contact your system administrator. The
battery icon displays and a soft beep will be heard while the Wireless Telephone is in use whenever the Battery Pack charge is low. User has 15-30 minutes of
Battery Pack life left. Battery low This message will display and an alarm will sound while the Wireless Telephone is idle whenever the Battery Pack is
critically low.
The Wireless Telephone cannot be used until the Battery Pack is charged. The voicemail icon indicates that you have a new voicemail message. Melody A
melody is played after the Wireless Telephone is powered on for the first time following a completed charge (Charge Complete). The Wireless Telephone
Headset NEC Business Solutions Ltd. offers optional headsets for use in noisy environments or if you need to have your hands free while talking on the
Wireless Telephone.
To use the headset, simply plug it into the jack on the bottom of the Wireless Telephone. The headset is specially designed to work properly with the MH110
Wireless Telephone. We do not recommend using other headsets. Figure 2-3 Bottom of the MH110 Wireless Telephone Headset jack Charging contacts
Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 2-8 Using the MH 110 Wireless Telephone Setting User Preferences
User preferences can be set through the vertical menus when the Wireless Telephone is in standby mode (on, but not in use). Use the following steps to set
user preferences. Step 1 Place the Wireless Telephone in standby mode. Refer to "Turning the Wireless Telephone On or Off" on page 2-2 for more
information regarding turning on the telephone. REFERENCE Step 2 Press and briefly hold FCN to display user options. Check with your system
administrator for specific features supported by your Wireless Telephone. NOTE Table 2-4 describes navigation tools that can be used when configuring user
preferences.
Table 2-4 User Preferences Navigation Tools Features Up/Down buttons Select button OK softkey Save softkey Bksp softkey Cncl softkey Up softkey Exit
softkey END CALL key Descriptions Displays previous/next menu item. Selects the menu item or option. Completes selection of the menu item or option. Saves
the entry. Backspaces to allow editing of entry. Cancels edit and returns to previous menu level. Returns to previous menu level. Exits the menu (at the top
level). Exits to standby state (from any level). User Option Menu Table 2-5 describes commands located on the User Option Menu.
Table 2-4 on page 2-8 describes available navigation tools. REFERENCE Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide Revision 1 Using the MH 110 Wireless Telephone 2-9 Table 2-5 User Option Menu Commands Commands Ring Type Descriptions Select Telephone Ring to
set the standard ring on the Wireless Telephone. · Normal: is the factory default ring. · Vib/Norm ring: vibrates for five seconds and then rings. · Vibrate ring:
vibrates for a non-audible call alert.
Actions Press 0 to select desired ring type. The ring type currently set displays with an asterisk. Noise Mode Adjusts the Wireless Telephone to account for
background noise. · Normal: for most office environments · High: for moderate background noise · Severe: for extremely noisy conditions. Select an option
that describes the noise in your environment.
Current IP address In IP systems, the IP address of the Wireless Telephone is displayed. This number may not be edited. Sets the extension number associated
with your Wireless Telephone. This number is used to identify the Wireless Telephone and is for display purposes only. None. Extension Use keypad to enter
extension number. Additional options may be present. Contact your system administrator for information. NOTE Battery Packs The Wireless Telephone's
Battery Pack must be recharged periodically. The Nickel Metal Hydride (NiMH) rechargeable Wireless Telephone Battery Pack gives you four hours of talk
time or 80 hours of stand-by time.
Stand-by time is when the phone is turned on, but not in an active call. NOTE Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide Revision 1 2-10 Using the MH 110 Wireless Telephone Low Battery Indicator The low battery icon displays when the Wireless Telephone battery is running
out of power. If the Wireless Telephone is in use, a soft beep also sounds through the earpiece every six seconds indicating that the user has 15-30 minutes of
battery life remaining. If the Wireless Telephone is not in a call when the battery begins to run out of power, only the low battery icon displays. If the battery
is not recharged and becomes critically low, a Low Battery message displays and a loud beep sounds. The Wireless Telephone will not work until the Battery
Pack is recharged. Be careful not to short-circuit the battery contacts on the Battery Pack. Batteries can be short-circuited if metal objects such as coins, keys
or paper clips cause a direct connection of the battery terminals. Shorting the contacts can cause permanent damage. CAUTION Removing and Replacing the
Battery Packs Use the following steps to remove and replace battery packs.
Step 1 Press down on the latch on the Battery Pack on the back of the Wireless Telephone. The Battery Pack releases outward as shown in Figure 2-4. Figure
2-4 MH110 Wireless Telephone--back and left side view UNIVERGE WL System Wireless Telephone (back and left side) with Battery Pack ajar Up Select
Down Latch Battery pack Lip Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 Using the MH 110 Wireless Telephone
2-11 Step 2 Step 3 Slide the lip of the Battery Pack into the bottom of the cavity.
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Push the top of the Battery Pack until it snaps into place. You should not have to force the Battery Pack into the Wireless Telephone.
NOTE Changing the Battery Pack During a Call The Battery Pack may be changed while a call is still in progress. Use the following steps to remove and
replace the battery pack while in a call. If you are using the Telephony Gateway in your telephone system, do not press Power Off/End Call on the Wireless
Telephone before beginning the following steps. Step 1 NOTE Quickly remove the discharged Battery Pack and replace with a charged Battery Pack. Refer to
"Removing and Replacing the Battery Packs" on page 2-10 for detailed instructions.
REFERENCE Step 2 Step 3 Press Power On/Start Call to turn the Wireless Telephone back on. Press Power On/Start Call again to resume the call in
progress. Users of IP telephony interfaces not requiring the UNIVERGE WL System Telephony Gateway should Park a call prior to changing the Battery
Pack during an active call. The call should then be retrieved after the Battery Pack is replaced to rejoin the conversation. Check with the switch administrator
for instruction on how to perform this or a similar process on your particular telephone system. REFERENCE Mobile Handset 110 Wireless Telephone and
Desktop Charger User Guide - Revision 1 2-12 Using the MH 110 Wireless Telephone Mobile Handset 110 Wireless Telephone and Desktop Charger User
Guide - Revision 1 3-1 3 Using the MH110 Desktop Charger The MH110 Desktop Charger is designed to charge the Nickel Metal Hydride (NiMH) Battery
Packs. Full charging is accomplished in approximately one and a half hours. Chargers operate in a 50° to 85° F (10° to 30° C) environment. Do not expose
them to freezing temperatures or direct sunlight. The MH110 Desktop Charger is shipped with the appropriate power supply for the site's location.
Place the MH110 Desktop Charger on a flat, horizontal surface. Plug the power supply into the MH110 Desktop Charger and into an appropriate wall outlet.
Do not place anything in the MH110 Desktop Charger other than the Wireless Telephone. You might damage the contacts. Bent contacts can keep the
Wireless Telephone from charging. CAUTION Chapter Topics · Using the MH110 Desktop Charger · Cleaning the MH110 Desktop Charger · Important
Notice Using the MH110 Desktop Charger The user must end any call in progress by pressing the Power Off/End Call button on the Wireless Telephone
before placing the handset into the MH110 Desktop Charger. The Wireless Telephone may be off or in standby mode during charging. Indicator Light Place
the MH110 Wireless Telephone into the MH110 Desktop Charger slot facing forward. If the Wireless Telephone is placed correctly, the red indicator light
will come on. The indicator light will not come on when the slot is empty, when the MH110 Wireless Telephone is improperly seated, or when the MH110
Desktop Charger has no power applied.
If the Wireless Telephone is in standby mode, it displays its extension number and Charging. . . . If the Wireless Telephone is turned off, only Charging.
. . displays. The dots will be racing during the charging cycle. It is normal for the Battery Pack to become warm when charging.
Charge Complete displays when the Wireless Telephone is fully charged. The indicator light remains on until the Wireless Telephone is removed. Charging
Indicator Charge Complete Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 3-2 Using the MH110 Desktop Charger
Cleaning the MH110 Desktop Charger Clean the MH110 Desktop Charger by wiping the surface with a clean, water-dampened cloth or paper towel. A mild
detergent solution may be used. Be sure to wipe away any detergent residue with a plain water dampened cloth. DO NOT IMMERSE THE MH110 Desktop
Charger IN WATER OR OTHER LIQUID. DO NOT POUR LIQUIDS INTO THE SLOT. IMPORTANT The Battery Pack contacts on the Wireless Telephone
may be cleaned with isopropyl (rubbing) alcohol applied with a Q-tip, cloth, or paper towel. Do not push or pull the exposed Battery Pack contacts. Important
Notice · Never use non-NEC Business Solutions Ltd.
charging units as they could damage the Battery Pack. · Only use the original plug-in power adapter for the MH110 Desktop Charger. · Do not dip the
Battery Pack in water or throw into the fire. · Do not throw away the Battery Pack with your domestic waste. Take used Battery Packs to an appropriate
collection point for recycling or send them back to your supplier or servicing agent. Replacement Battery Packs are available from your supplier or servicing
agent. Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 4-1 4 Care of the Wireless Telephone and Chargers
Precautions and tips contained in this chapter apply equally to the MH110 Wireless Telephone and the MH110 Desktop Charger. Chapter Topics ·
Precautions · Cleaning tips · Usage Tips Precautions Do not drop Do not disassemble Avoid dropping the Wireless Telephone or knocking it against hard
surfaces. Carrying the Wireless Telephone in a holster or carrying case will help to protect it. There are no serviceable parts in the Wireless Telephone or
MH110 Desktop Charger.
You should not open the Wireless Telephone case nor disassemble the MH110 Desktop Charger. Doing so will void your warranty. Cleaning tips Use the
following cleaning tips to maintain your Wireless Telephone and Desktop Charger. · Turn off the Wireless Telephone and unplug the MH110 Desktop
Charger before you clean them. Please observe the following guidelines: · Never immerse either in water.
· Clean the exterior surfaces, including the charging contacts, with a cloth that has been slightly moistened with water. · Do not exert undue pressure on the
MH110 Desktop Charger electrical contacts while wiping. Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 4-2 Care
of the Wireless Telephone and Chargers · Wiping the handset surface with a water-dampened cloth or paper towel will remove most films or residues.
@@@@@@@@· When using alcohol, do not rub the keypad characters vigorously. Doing so will significantly degrade legibility.
DO NOT SPRAY THE HANDSET DIRECTLY! CAUTION · Pre-treated cloths such as used for eyeglasses or cameras may be used to clean the phone. Premoistened towelettes may also be used to clean the phone, however, avoid those containing lanolin or aloe as it will leave a slippery residue. · The surface of
the handset may be cleaned occasionally with disinfectants used for general cleaning in a medical environment. · Isopropyl alcohol may be used occasionally
applied by a damp cloth or paper towel. When using alcohol, do not rub the keypad characters vigorously. Doing so will significantly degrade legibility.

You're reading an excerpt. Click here to read official NEC MH110
user guide
http://yourpdfguides.com/dref/2311207

· Do not use furniture polishes, waxes or plasticizer-based cleaners. · Do not use lanolin, aloe, glycerin or other skin care type products. · Do not apply any
solvent such as acetone, mineral spirits etc. · Do not directly spray or immerse the handset.
· If the headset connector becomes dirty, a scratchy or intermittent signal may be experienced. To clean the connector, dip the nonpadded end of either a
wooden or paper handled cotton swab in isopropyl alcohol. Gently insert in the connector and twist, repeating several times. If available, blow compressed
air into the connector to clear debris. Usage Tips Please observe the following usage guidelines: · Before you use the Wireless Telephone, the Battery Pack
must be charged. · You can only use the Wireless Telephone with your facility's telephone system. It is not a public cellular phone. · Keep the Wireless
Telephone away from your ear when it is ringing. Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide - Revision 1 Care of the
Wireless Telephone and Chargers 4-3 · The microphone is between the FCN and LINE keys. This is a sensitive microphone that works well when the Wireless
Telephone is correctly positioned on your ear.
There is no need to speak directly into the microphone, but do not cover it with your hand or cheek when talking. · The LCD panel displays information about
the status of your Wireless Telephone and prompts you about features. · If the Battery Pack is low, you will hear a soft beep and see the battery icon in the
display. · Improper disposal of Battery Packs can damage the environment. Dispose of batteries properly.
· You can control the Wireless Telephone volume level and the type of ring. · To protect the Wireless Telephone, use a carrying case. Mobile Handset 110
Wireless Telephone and Desktop Charger User Guide - Revision 1 4-4 Care of the Wireless Telephone and Chargers Mobile Handset 110 Wireless Telephone
and Desktop Charger User Guide - Revision 1 For additional information or support on this NEC Business Solutions product, contact your NEC Business
Solutions representative. NEC Business Solutions Ltd. Mobile Handset 110 Wireless Telephone and Desktop Charger User Guide NEC-9121, Revision 1 .
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